The MSP-EXP430FR4133 LaunchPad™ Development Kit is an easy-to-use evaluation module (EVM) for the MSP430FR4133 microcontroller (see Figure 1). It contains everything needed to start developing on the MSP430™ ultra-low-power (ULP) FRAM-based microcontroller (MCU) platform, including on-board emulation for programming, debugging, and energy measurements. The board features on-board buttons and LEDs for quick integration of a simple user interface and a liquid crystal display (LCD) that showcases the integrated driver with flexible software-configurable pins.

Figure 1. MSP-EXP430FR4133
1 Getting Started

1.1 Introduction

The MSP-EXP430FR4133 LaunchPad™ Development Kit is an easy-to-use Evaluation Module (EVM) for the MSP430FR4133 microcontroller (see Figure 1). It contains everything needed to start developing on the MSP430™ ultra-low-power (ULP) FRAM-based microcontroller (MCU) platform, including on-board emulation for programming, debugging, and energy measurements. The board features on-board buttons and LEDs for quick integration of a simple user interface and a liquid crystal display (LCD) that showcases the integrated driver with flexible software-configurable pins. The MSP430FR4133 device features embedded FRAM (ferroelectric random access memory), a nonvolatile memory known for its ultra-low power, high endurance, and high-speed write access.

Rapid prototyping is simplified by the 20-pin BoosterPack™ Plug-in Module headers, which support a wide range of available BoosterPacks. You can quickly add features like wireless connectivity, graphical displays, environmental sensing, and much more. Design your own BoosterPack or choose among many already available from TI and third-party developers.

Free software development tools are also available, including TI’s Eclipse-based Code Composer Studio™ (CCSTUDIO) and IAR Embedded Workbench® IAR-KICKSTART. Both of these integrated development environments (IDEs) support EnergyTrace™ technology when paired with the MSP430FR4133 LaunchPad. More information about the LaunchPad, the supported BoosterPacks, and available resources can be found at TI’s LaunchPad portal.

1.2 Key Features

- MSP430 ultra-low-power FRAM technology based MSP430FR4133 16-bit MCU
- 20-pin LaunchPad standard that leverages the BoosterPack ecosystem
- eZ-FET, an open-source onboard debugger that features EnergyTrace technology
- On-board segmented LCD
- Two buttons and two LEDs for user interaction
- Backchannel UART through USB to PC

1.3 What’s Included

1.3.1 Kit Contents

- 1 x MSP-EXP430FR4133 LaunchPad Development Kit
- 1 x micro-USB cable
- 1 x Quick Start Guide

1.3.2 Software Examples

- Out-of-Box Software

1.4 First Steps: Out-of-Box Experience

An easy way to get familiar with the EVM is by using its preprogrammed out-of-box code. It demonstrates some key features from a user level.
1.4.1 Connecting to the Computer

Connect the LaunchPad using the included USB cable to a computer. A green power LED should illuminate. For proper operation, drivers are needed. It is recommended to get drivers by installing an IDE such as TI's CCS or IAR EW430. Drivers are also available at www.ti.com/MSPdrivers.

1.4.2 Running the Out-of-Box Demo

When connected to the computer, the LaunchPad powers up and displays a greeting message on the LCD. Press and hold the S1 and S2 buttons simultaneously to select a new mode. A more detailed explanation of each mode can be found in Section 3.4.

1.4.2.1 Stopwatch Mode

This mode provides a simple stopwatch application. It supports split time, where the display freezes while the stopwatch continues running in the background.

Timer Stopped:
S1: Start time
S2: Reset time

Timer Running:
S1: Stop time
S2: Split time (lap time)

1.4.2.2 Temperature Mode

This mode provides a simple thermometer application. Using the on-chip temperature sensor, the temperature is displayed on the LCD.

S1: Pause current temperature
S2: Toggle temperature between °F and °C

1.5 Next Steps: Looking Into the Provided Code

After the EVM features have been explored, the fun can begin. It's time to open an integrated development environment and start editing the code examples. Refer to Section 3.3 for more information on IDEs and where to download them.

The out-of-box source code and more code examples are provided for download at http://www.ti.com/tool/msp-exp430fr4133. Code is licensed under BSD, and TI encourages reuse and modifications to fit specific needs.

Section 3 describes all of the functions in detail and describes the project structure to help familiarize you with the code.

With the onboard eZ-FET emulator debugging and downloading new code is simple. A USB connection between the EVM and a PC through the provided USB cable is all that is needed.
2 Hardware

Figure 2 shows an overview of the MSP-EXP430FR4133 hardware.

- **eZ-FET on-board emulator**: Enables debugging/programming as well as communication back to the PC. The eZ-FET can also provide power to the target MCU.
- **Introducing EnergyTrace™ Technology**: Real-time power consumption readings and state updates from the MSP430FR4133 MCU, including CPU and peripheral state are viewable through the EnergyTrace GUI.
- **Jumpers to isolate emulator from target MCU (J101)**:
  - Back-channel UART to PC (RTS, CTS, RXD, TXD)
  - Spy-Bi-Wire debug (SBWTDIO/SBWTCK)
  - Power (5V, 3V3, and GND)
- **20-pin BoosterPack plug-in module connector (J1 and J2)**
- **MSP430FR4133 Microcontroller** (MSP1)
- **Reset**
- **Segmented LCD Display**
  - 6 alphanumeric characters
  - 6 symbols for various applications
  - Ultra-low power display

Figure 2. MSP-EXP430FR4133 Overview
2.1 Block Diagram

Figure 3 shows the block diagram.

2.2 Hardware Features

2.2.1 MSP430FR4133

The MSP430FR4133 is the next device in TI's new ULP FRAM technology platform. FRAM is a cutting edge memory technology, combining the best features of flash and RAM into one nonvolatile memory.

Device features include:

- 1.8-V to 3.6-V operation
- Up to 16-MHz system clock and 8-MHz FRAM access
- 16KB of nonvolatile FRAM
- Industry's lowest-power LCD controller
- IR modulation logic
- Two timer blocks and up to three serial interfaces (SPI, UART, or I²C)
- Analog: 10-channel 10-bit differential ADC
- Digital: RTC, CRC
Figure 4. MSP430FR4133 Pinout
2.2.2 eZ-FET Onboard Emulator With EnergyTrace™ Technology

To keep development easy and cost effective, TI's LaunchPad Development Kits integrate an onboard emulator, which eliminates the need for expensive programmers. The MSP-EXP430FR4133 has the eZ-FET emulator (see Figure 5), which is a simple and low-cost debugger that supports all MSP430 device derivatives.

![Figure 5. eZ-FET Emulator](image)

The MSP-EXP430FR4133 LaunchPad features EnergyTrace technology but does not have support for EnergyTrace++™ technology. The EnergyTrace functionality varies across the MSP portfolio (see Table 1).

<table>
<thead>
<tr>
<th>Feature</th>
<th>EnergyTrace™ Technology</th>
<th>EnergyTrace++™ Technology</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Monitoring</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>CPU State</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Peripheral and System State</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Devices Supported</td>
<td>All MSP430 MCUs</td>
<td>MSP430FR59xx and MSP430FR69xx MCUs</td>
</tr>
<tr>
<td>Development Tool Required</td>
<td>MSP-FET or eZ-FET</td>
<td>MSP-FET or eZ-FET</td>
</tr>
</tbody>
</table>

The eZ-FET also provides a "backchannel" UART-over-USB connection with the host, which can be very useful during debugging and for easy communication with a PC. The provided UART supports hardware flow control (RTS and CTS), although by default these signals are not connected to the target.

The dotted line through J101 shown in Figure 5 divides the eZ-FET emulator from the target area. The signals that cross this line can be disconnected by jumpers on J101, the isolation jumper block. More details on the isolation jumper block are in Section 2.2.3.

The eZ-FET hardware can be found in the schematics in Section 6 and in the accompanying MSP-EXP430FR4133 Hardware Design Files. The software and more information about the debugger can be found on the eZ-FET lite wiki.
2.2.3 Emulator Connection: Isolation Jumper Block

The isolation jumper block at jumper J101 allows the user to connect or disconnect signals that cross from the eZ-FET domain into the MSP430FR4133 target domain. This includes eZ-FET Spy-Bi-Wire signals, application UART signals, and 3.3-V and 5-V power (see Table 2 and Figure 6).

Reasons to open these connections:
- To remove any and all influence from the eZ-FET emulator for high accuracy target power measurements
- To control 3-V and 5-V power flow between the eZ-FET and target domains
- To expose the target MCU pins for other use than onboard debugging and application UART communication
- To expose the programming and UART interface of the eZ-FET so that it can be used for devices other than the onboard MCU.

Table 2. Isolation Block Connections

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>5V</td>
<td>5-V VBUS from USB</td>
</tr>
<tr>
<td>3V3</td>
<td>3.3-V rail, derived from VBUS by an LDO in the eZ-FET domain</td>
</tr>
<tr>
<td>RTS &gt;&gt;</td>
<td>Backchannel UART: Ready-To-Send, for hardware flow control. The target can use this to indicate whether it is ready to receive data from the host PC. The arrows indicate the direction of the signal.</td>
</tr>
<tr>
<td>CTS &lt;&lt;</td>
<td>Backchannel UART: Clear-To-Send, for hardware flow control. The host PC (through the emulator) uses this to indicate whether it is ready to receive data. The arrows indicate the direction of the signal.</td>
</tr>
<tr>
<td>RXD &lt;&lt;</td>
<td>Backchannel UART: The target FR4133 receives data through this signal. The arrows indicate the direction of the signal.</td>
</tr>
<tr>
<td>TXD &gt;&gt;</td>
<td>Backchannel UART: The target FR4133 sends data through this signal. The arrows indicate the direction of the signal.</td>
</tr>
<tr>
<td>SBW RST</td>
<td>Spy-Bi-Wire emulation: SBWTDIO data signal. This pin also functions as the RST signal (active low).</td>
</tr>
<tr>
<td>SBW TST</td>
<td>Spy-Bi-Wire emulation: SBWTCK clock signal. This pin also functions as the TST signal.</td>
</tr>
</tbody>
</table>
2.2.4 Application (or "Backchannel") UART

The backchannel UART allows communication with the USB host that is not part of the target application's main functionality. This is useful during development and also provides a communication channel to the PC host side. This can be used to create graphical user interfaces (GUIs) and other programs on the PC that communicate with the LaunchPad.

The pathway of the backchannel UART is shown in Figure 6. The backchannel UART is the UART on eUSCI_A0. Because of USCI limitations, this UART channel is shared with the UART on the 20-pin BoosterPack connector (eUSCI_A0). This UART channel is also shared with the red LED on P1.0. This is a lot of sharing, but all 64 pins of the device are used and this was done out of necessity. The P1.0 pin serves more functions than any other.

On the host side, a virtual COM port for the application backchannel UART is generated when the LaunchPad enumerates on the host. You can use any PC application that interfaces with COM ports, including terminal applications like Hyperterminal or Docklight, to open this port and communicate with the target application. You need to identify the COM port for the backchannel. On Windows PCs, Device Manager can assist (see Figure 7).

![Figure 7. Application Backchannel UART in Device Manager](image-url)
The backchannel UART is the "MSP Application UART1" port. In this case, Figure 7 shows COM13, but this port can vary from one host PC to the next. After you identify the correct COM port, configure it in your host application according to its documentation. You can then open the port and begin communication to it from the host.

On the target MSP430FR4133 side, the backchannel is connected to the eUSCI_A0 module. The eZ-FET has a configurable baud rate; therefore, it is important that the PC application configures the baud rate to be the same as what is configured on the eUSCI_A0.

The eZ-FET also supports hardware flow control, if desired. Hardware flow control (CTS and RTS handshaking) allows the target MSP430FR4133 and the emulator to tell each other to wait before sending more data. At low baud rates and with simple target applications, flow control may not be necessary. Applications with higher baud rates and more interrupts to service have a higher likelihood that the will not be able to read the eUSCI_A0 RXBUF register in time, before the next byte arrives. If this happens, the eUSCI_A0 UCA0STATW register reports an overrun error.

### 2.2.5 Special Features

#### 2.2.5.1 Liquid Crystal Display (LCD)

The MSP430FR4133 LaunchPad features an on-board LCD (see Figure 8). This LCD is driven by the internal LCD driver on the MSP430FR4133 device.

![Figure 8. LCD Segment Layout](image-url)
There are many available LCD segments, including six full alpha-numeric numbers and letters in addition to several symbols at the top for various modes or applications. Table 3 shows the mapping of these segments.

**Table 3. LCD FH-1138P Segment Mapping**

<table>
<thead>
<tr>
<th>Pin</th>
<th>COM3</th>
<th>COM2</th>
<th>COM1</th>
<th>COM0</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A1E</td>
<td>A1F</td>
<td>A1G</td>
<td>A1M</td>
</tr>
<tr>
<td>2</td>
<td>A1A</td>
<td>A1B</td>
<td>A1C</td>
<td>A1D</td>
</tr>
<tr>
<td>3</td>
<td>A1Q</td>
<td>NEG</td>
<td>A1N</td>
<td>A1DP</td>
</tr>
<tr>
<td>4</td>
<td>A1H</td>
<td>A1J</td>
<td>A1K</td>
<td>A1P</td>
</tr>
<tr>
<td>5</td>
<td>A2E</td>
<td>A2F</td>
<td>A2G</td>
<td>A2M</td>
</tr>
<tr>
<td>6</td>
<td>A2A</td>
<td>A2B</td>
<td>A2C</td>
<td>A2D</td>
</tr>
<tr>
<td>7</td>
<td>A2Q</td>
<td>A2COL</td>
<td>A2N</td>
<td>A2DP</td>
</tr>
<tr>
<td>8</td>
<td>A2H</td>
<td>A2J</td>
<td>A2K</td>
<td>A2P</td>
</tr>
<tr>
<td>9</td>
<td>A3R</td>
<td>A3F</td>
<td>A3G</td>
<td>A3M</td>
</tr>
<tr>
<td>10</td>
<td>A3A</td>
<td>A3B</td>
<td>A3C</td>
<td>A3D</td>
</tr>
<tr>
<td>11</td>
<td>A3Q</td>
<td>ANT</td>
<td>A3N</td>
<td>A3DP</td>
</tr>
<tr>
<td>12</td>
<td>A3H</td>
<td>A3J</td>
<td>A3K</td>
<td>A3P</td>
</tr>
<tr>
<td>13</td>
<td>A4R</td>
<td>A4F</td>
<td>A4G</td>
<td>A4M</td>
</tr>
<tr>
<td>14</td>
<td>A4A</td>
<td>A4B</td>
<td>A4C</td>
<td>A4D</td>
</tr>
<tr>
<td>15</td>
<td>A4Q</td>
<td>A4COL</td>
<td>A4N</td>
<td>A4DP</td>
</tr>
<tr>
<td>16</td>
<td>A4H</td>
<td>A4J</td>
<td>A4K</td>
<td>A4P</td>
</tr>
<tr>
<td>17</td>
<td>A5E</td>
<td>A5F</td>
<td>A5G</td>
<td>A5M</td>
</tr>
<tr>
<td>18</td>
<td>A5A</td>
<td>A5B</td>
<td>A5C</td>
<td>A5D</td>
</tr>
<tr>
<td>19</td>
<td>A5Q</td>
<td>DEG</td>
<td>A5N</td>
<td>A5DP</td>
</tr>
<tr>
<td>20</td>
<td>A5H</td>
<td>A5J</td>
<td>A5K</td>
<td>A5P</td>
</tr>
<tr>
<td>21</td>
<td>COM3</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>22</td>
<td>-</td>
<td>COM2</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>23</td>
<td>-</td>
<td>-</td>
<td>COM1</td>
<td>-</td>
</tr>
<tr>
<td>24</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>COM0</td>
</tr>
<tr>
<td>25</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>26</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>27</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>28</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>29</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>30</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>31</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>32</td>
<td>TMR</td>
<td>HRT</td>
<td>REC</td>
<td>!</td>
</tr>
<tr>
<td>33</td>
<td>B6</td>
<td>B4</td>
<td>B2</td>
<td>BATT</td>
</tr>
<tr>
<td>34</td>
<td>B5</td>
<td>B3</td>
<td>B1</td>
<td>[]</td>
</tr>
<tr>
<td>35</td>
<td>A6E</td>
<td>A6F</td>
<td>A6G</td>
<td>A6M</td>
</tr>
<tr>
<td>36</td>
<td>A6A</td>
<td>A6B</td>
<td>A6C</td>
<td>A6D</td>
</tr>
<tr>
<td>37</td>
<td>A6Q</td>
<td>TX</td>
<td>A6N</td>
<td>RX</td>
</tr>
<tr>
<td>38</td>
<td>A6H</td>
<td>A6J</td>
<td>A6K</td>
<td>A6P</td>
</tr>
</tbody>
</table>
The MSP430FR4133 device has flexible LCD pins allowing any pin to be a SEG or a COM. This simplifies layout for the user. The LCD connections are typically a tradeoff between easy layout and optimal memory settings for cleaner user software, among other considerations. The flexibility of the MSP430FR4133 allowed an optimal memory setting for easy software, along with a simple layout on the PCB (see Table 4).

Each LCDMEM register is eight bits, controlling up to eight segments. The FH-1138P is a 4-mux LCD, so four COM pins are needed from the MSP430FR4133. With four COM pins, each segment pin controls four bits or segments. This means that each LCDMEM register controls two segment pins, as shown in Table 4. Note that LCDMEM14 to LCDMEM17 and LCDMEM20 and higher are not used due to layout considerations.

Each alphanumeric character A1 to A6 is controlled by two adjacent LCDMEM registers for efficiency and ease of use in software. This allows for a single 16-bit memory access to control the whole character, as opposed to split memory regions requiring separate memory accesses.

### Table 4. LCD to MSP430 Connections

<table>
<thead>
<tr>
<th>LCDMEM</th>
<th>Port Pin</th>
<th>FR4133 Pin</th>
<th>LCD Pin</th>
<th>COM3</th>
<th>COM2</th>
<th>COM1</th>
<th>COM0</th>
<th>Port Pin</th>
<th>FR4133 Pin</th>
<th>LCD Pin</th>
<th>COM3</th>
<th>COM2</th>
<th>COM1</th>
<th>COM0</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCDM19</td>
<td>P5.7</td>
<td>L39</td>
<td>38</td>
<td>A6H</td>
<td>A6J</td>
<td>A6K</td>
<td>A6P</td>
<td>P5.6</td>
<td>L38</td>
<td>37</td>
<td>A6O</td>
<td>TX</td>
<td>A6N</td>
<td>RX</td>
</tr>
<tr>
<td>LCDM18</td>
<td>P5.5</td>
<td>L37</td>
<td>36</td>
<td>A6A</td>
<td>A6B</td>
<td>A6C</td>
<td>A6D</td>
<td>P5.4</td>
<td>L36</td>
<td>35</td>
<td>A6E</td>
<td>A6F</td>
<td>A6G</td>
<td>A6M</td>
</tr>
<tr>
<td>LCDM17</td>
<td>P5.3</td>
<td>L35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>P5.2</td>
<td>L34</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LCDM16</td>
<td>P5.1</td>
<td>L33</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>P5.0</td>
<td>L32</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LCDM15</td>
<td>P2.7</td>
<td>L31</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>P2.6</td>
<td>L30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LCDM14</td>
<td>P2.5</td>
<td>L29</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>P2.4</td>
<td>L28</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LCDM13</td>
<td>P2.3</td>
<td>L27</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>P2.2</td>
<td>L26</td>
<td>34</td>
<td>B5</td>
<td>B3</td>
<td>B1</td>
<td>[ ]</td>
</tr>
<tr>
<td>LCDM12</td>
<td>P2.1</td>
<td>L25</td>
<td>33</td>
<td>B6</td>
<td>B4</td>
<td>B2</td>
<td>BATT</td>
<td>P2.0</td>
<td>L24</td>
<td>32</td>
<td>TMR</td>
<td>HRT</td>
<td>REC</td>
<td>!</td>
</tr>
<tr>
<td>LCDM10</td>
<td>P6.5</td>
<td>L21</td>
<td>14</td>
<td>A4A</td>
<td>A4B</td>
<td>A4C</td>
<td>A4D</td>
<td>P6.4</td>
<td>L20</td>
<td>13</td>
<td>A4R</td>
<td>A4F</td>
<td>A4G</td>
<td>A4M</td>
</tr>
<tr>
<td>LCDM9</td>
<td>P6.3</td>
<td>L19</td>
<td>12</td>
<td>A3H</td>
<td>A3J</td>
<td>A3K</td>
<td>A3P</td>
<td>P6.2</td>
<td>L18</td>
<td>11</td>
<td>A3Q</td>
<td>ANT</td>
<td>A3N</td>
<td>A3DP</td>
</tr>
<tr>
<td>LCDM7</td>
<td>P3.7</td>
<td>L15</td>
<td>8</td>
<td>A2H</td>
<td>A2J</td>
<td>A2K</td>
<td>A2P</td>
<td>P3.6</td>
<td>L14</td>
<td>7</td>
<td>A2Q</td>
<td>A2COL</td>
<td>A2N</td>
<td>A2DP</td>
</tr>
<tr>
<td>LCDM6</td>
<td>P3.5</td>
<td>L13</td>
<td>6</td>
<td>A2A</td>
<td>A2B</td>
<td>A2C</td>
<td>A2D</td>
<td>P3.4</td>
<td>L12</td>
<td>5</td>
<td>A2E</td>
<td>A2F</td>
<td>A2G</td>
<td>A2M</td>
</tr>
<tr>
<td>LCDM3</td>
<td>P7.7</td>
<td>L7</td>
<td>20</td>
<td>A5H</td>
<td>A5J</td>
<td>A5K</td>
<td>A5P</td>
<td>P7.6</td>
<td>L6</td>
<td>19</td>
<td>A5Q</td>
<td>DEG</td>
<td>A5N</td>
<td>A5DP</td>
</tr>
<tr>
<td>LCDM2</td>
<td>P7.5</td>
<td>L5</td>
<td>18</td>
<td>A5A</td>
<td>A5B</td>
<td>A5C</td>
<td>A5D</td>
<td>P7.4</td>
<td>L4</td>
<td>17</td>
<td>A5E</td>
<td>A5F</td>
<td>A5G</td>
<td>A5M</td>
</tr>
<tr>
<td>LCDM1</td>
<td>P7.3</td>
<td>L3</td>
<td>21</td>
<td>COM3</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>P7.2</td>
<td>L2</td>
<td>22</td>
<td>-</td>
<td>COM2</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>LCDM0</td>
<td>P7.1</td>
<td>L1</td>
<td>23</td>
<td>-</td>
<td>-</td>
<td>COM1</td>
<td>-</td>
<td>P7.0</td>
<td>L0</td>
<td>24</td>
<td>-</td>
<td>-</td>
<td>COM0</td>
<td>-</td>
</tr>
</tbody>
</table>
2.3 Power

The board was designed to accommodate various powering methods, including through the on-board eZ-FET and from external or BoosterPack power (see Figure 9).

2.3.1 eZ-FET USB Power

The most common power-supply scenario is from USB through the eZ-FET debugger. This provides 5-V power from the USB and also regulates this power rail to 3.3 V for eZ-FET operation and 3.3 V to the target side of the LaunchPad. Power from the eZ-FET is controlled by jumper J101. For 3.3 V, make sure that a jumper is connected across the J101 3V3 terminal.

2.3.2 BoosterPack and External Power Supply

Header J6 is present on the board to supply external power directly. It is important to comply with the device voltage operation specifications when supplying external power. The MSP430FR4133 has an operating range of 1.8 V to 3.6 V. More information can be found in the MSP430FR4133 data sheet (SLAS865).
2.4 **Measure MSP430 Current Draw**

To measure the current draw of the MSP430FR4133 using a multi-meter, use the 3V3 jumper on the jumper isolation block. The current measured includes the target device and any current drawn through the BoosterPack headers.

To measure ultra-low power, follow these steps:

1. Remove the 3V3 jumper in the isolation block, and attach an ammeter across this jumper.
2. Consider the effect that the backchannel UART and any circuitry attached to the MSP430FR4133 may have on current draw. Consider disconnecting these at the isolation jumper block, or at least consider their current sinking and sourcing capability in the final measurement.
3. Make sure there are no floating input/output (I/Os). These cause unnecessary extra current draw. Every I/O should either be driven out or, if it is an input, should be pulled or driven to a high or low level.
4. Begin target execution.
5. Measure the current. Keep in mind that if the current levels are fluctuating, it may be difficult to get a stable measurement. It is easier to measure quiescent states.

Alternatively, EnergyTrace technology can be used to measure the same current, and see energy profiles through integrated GUI in CCS and IAR. EnergyTrace allows you to compare various current profiles and better optimize your energy performance!

2.5 **Clocking**

The MSP-EXP430FR4133 provides an external clock in addition to the internal clocks in the device.

- **Y1**: a 32-kHz crystal

The 32-kHz crystal allows for lower LPM3 sleep currents than do the other low-frequency clock sources. Therefore, the presence of the crystal allows the full range of low-power modes to be used.

The internal clocks in the device default to the following configuration:

- **MCLK**: DCO, 2 MHz
- **SMCLK**: DCO, 2 MHz
- **ACLK**: REFO, 32.768 kHz

For more information about configuring internal clocks and using the external oscillators, see the **MSP430FR4xx and MSP430FR2xx Family User's Guide (SLAU445)**.

2.6 **Using the eZ-FET Emulator With a Different Target**

The eZ-FET emulator on the LaunchPad can interface to most MSP430 derivative devices, not just the onboard MSP430FR4133 target device.

To do this, disconnect every jumper in the isolation jumper block. This is necessary, because the emulator cannot connect to more than one target at a time over the Spy-Bi-Wire (SBW) connection.

Next, make sure the target board has proper connections for SBW. Note that to be compatible with SBW, the capacitor on RST/SBWT Dio cannot be greater than 2.2 nF. The documentation for designing MSP430 JTAG interface circuitry is the **MSP430 Hardware Tools User's Guide (SLAU278)**.

Finally, wire together these signals from the emulator side of the isolation jumper block to the target hardware:

- **5 V** (if 5 V is needed)
- **3.3 V**
- **GND**
- **SBWT Dio**
- **SBWT Ck**
- **TXD** (if the UART backchannel is used)
- **RXD** (if the UART backchannel is used)
- **CTS** (if hardware flow control is used)
- **RTS** (if hardware flow control is used)

This wiring can be done either with jumper wires or by designing the board with a connector that plugs into the isolation jumper block.
2.7 **BoosterPack Pinout**

The LaunchPad adheres to the 20-pin LaunchPad pinout standard. A standard was created to aid compatibility between LaunchPad and BoosterPack tools across the TI ecosystem.

The 20-pin standard is compatible with the 40-pin standard that is used by other LaunchPads like the MSP-EXP430F5529LP. This allows some subset of functionality of 40-pin Booster Packs to be used with 20-pin LaunchPads.

While most Booster Packs are compliant with the standard, some are not. The MSP-EXP430FR4133 LaunchPad is compatible with all 20-pin Booster Packs that are compliant with the standard. If the reseller or owner of the BoosterPack does not explicitly indicate compatibility with the MSP-EXP430FR4133 LaunchPad, compare the schematic of the candidate BoosterPack with the LaunchPad to ensure compatibility. Keep in mind that sometimes conflicts can be resolved by changing the MSP430FR4133 device pin function configuration in software. More information about compatibility can also be found at http://www.ti.com/launchpad.

Figure 10 shows the 20-pin pinout of the MSP430FR4133 LaunchPad.

Note that software's configuration of the pin functions plays a role in compatibility. The LaunchPad side of the dashed line in Figure 10 shows all of the functions for which the MSP430FR4133 device's pins can be configured. This can also be seen in the MSP430FR4133 data sheet. The BoosterPack side of the dashed line shows the standard. The LaunchPad function whose color matches the BoosterPack function shows the specific software-configurable function by which the MSP430FR4133 LaunchPad adheres to the standard.

The following pins are exposed at the BoosterPack connector.

---

* Note that to comply with the I2C channels of the BoosterPack standard, a software-emulated I2C must be used.

** Some LaunchPads do not 100% comply with the standard, please check your LaunchPad to ensure compatibility.

(!) Denotes I/O pins that are interrupt-capable.

---

**Figure 10. LaunchPad to BoosterPack Connector Pinout**
2.8 Design Files

2.8.1 Hardware

Schematics can be found in Section 6. All design files including schematics, layout, bill of materials (BOM), Gerber files, and documentation are available in the MSP-EXP430FR4133 Hardware Design Files.

2.8.2 Software

All design files including TI-TXT object-code firmware images, software example projects, and documentation are available in the MSP-EXP430FR4133 Software Examples.

2.9 Hardware Change Log

Table 5. Hardware Change Log

<table>
<thead>
<tr>
<th>PCB Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rev 1.0</td>
<td>Initial release</td>
</tr>
<tr>
<td>Rev 1.1</td>
<td>Added CE marking to silkscreen for compliance. No functional or layout change.</td>
</tr>
</tbody>
</table>

3 Software Examples

The software examples included with the MSP430FR4133 LaunchPad can be found in the MSP-EXP430FR4133 Software Examples.

Table 6. Software Examples

<table>
<thead>
<tr>
<th>Demo Name</th>
<th>BoosterPack Required</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>OutOfBox_FR4133</td>
<td>None</td>
<td>The out-of-box demo pre-programmed on the LaunchPad from the factory. Demonstrates features of MSP430FR4133 device</td>
<td>Section 3.4</td>
</tr>
</tbody>
</table>

3.1 Precompiled Binary

The /Binary/ folder inside the MSP-EXP430FR4133 Software Examples includes precompiled TI-TXT binary files for each of the projects in Table 6 that are ready to be flashed onto the LaunchPad. A copy of the MSP430Flasher tool is also shipped to interface with the eZ-FET Emulator.

To quickly program a demo onto the LaunchPad, simply navigate into the corresponding demo project's directory and double click the "Program <Example>.bat" file.
Figure 11. Programming the LaunchPad With Program Batch Files

If desired, the "Program <Example>.bat" file can be modified to point to your own projects' binary file.

**NOTE:** After importing and compiling the software source code in an IDE such as CCS or IAR, the TI-TXT binary files located in the /Binary/ folder are not updated automatically. Copy the newly compiled binary from your IDE's /Workspace/Project/ directory and replace the "<Example>.txt" in /Binary/ for the batch file to program your own binary file.

### 3.2 MSP430Ware Library

The examples are built upon MSP430 libraries shown below that are available from TI. All libraries are available as part of MSP430Ware. Downloading CCS includes MSP430Ware along with TI Resource Explorer.

- **Driver library (MSP430DRIVERLIB):** a foundational MSP430 software library that is useful for interfacing with all MSP430 core functions and peripherals, especially clocks and power.
- **Graphics library (MSP430-GRLIB):** a library for interfacing MSP430 devices to dot-matrix LCD displays. Contains primitives for simple drawing as well as images and more.
- **Capacitive Touch Library (CAPSENSELIBRARY):** a library for capacitive touch sensing applications. This library supports the use of buttons, sliders, wheels and more. Highly configurable for each application.

When you begin your own development, you will need more information about these libraries than can be included in this user's guide. All of the information that you need is in MSP430Ware or the specific library documentation linked above.

### 3.3 Development Environment Requirements

To use any of the software examples with the LaunchPad, you must have an IDE that supports the MSP430FR4133 device (see Table 7). For more details on where to download the latest IDE, see Section 4.3.

<table>
<thead>
<tr>
<th>Table 7. IDE Minimum Requirements for MSP-EXP430FR4133</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code Composer Studio™ IDE</strong></td>
</tr>
<tr>
<td>CCS v6.0 or later</td>
</tr>
</tbody>
</table>
3.3.1 CCS

CCS v6.0 or later is required. When CCS has been launched, and a workspace directory chosen, use Project>Import Existing CCS Eclipse Project. Direct it to the desired demo project directory that contains main.c (see Figure 12). Selecting the \CCS subdirectory also works. The CCS-specific files are located there.

![Figure 12. Directing the Project>Import Function to the Demo Project](image)

When you click OK, CCS should recognize the project and allow you to import it. The indication that CCS has found the project is that it appears in "Discovered projects" and is checked (see Figure 13).
3.3.2 IAR

IAR 6.10 or higher is required. To open the demo in IAR, click File>Open>Workspace…, and browse to the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is contained within this file.

The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by clicking Project>Add-Existing-Project….

Although the software examples have all of the code required to run them, IAR users may download and install MSP430Ware, which contains MSP430 libraries and the TI Resource Explorer. These are already included in a CCS installation (unless the user selected otherwise).

3.4 Out-of-Box Software Example

This section describes the functionality and structure of the out-of-box software that is preloaded on the EVM.

There are two modes in the out-of-box software, stopwatch mode and temperature sensor mode, which can be controlled with S1 and S2 push buttons on the LaunchPad. This demo shows how to utilize the LCD_E module (active in low power mode 3.5), combined with the RTC counter, ADC, and internal temperature sensor, to implement simple stopwatch and thermometer.
3.4.1 Source File Structure

The project is split into multiple files. This makes it easier to navigate and reuse parts of it for other projects.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>main.c</td>
<td>The out-of-box demo main function, initializations, shared ISRs, and so on</td>
</tr>
<tr>
<td>hal_LCD.c</td>
<td>Hardware abstraction layer for LCD</td>
</tr>
<tr>
<td>StopWatchMode.c</td>
<td>Main function file for stopwatch mode</td>
</tr>
<tr>
<td>TempSensorMode.c</td>
<td>Main function file for live thermometer mode</td>
</tr>
<tr>
<td>Library: Driverlib</td>
<td>Device driver library (MSP430DRIVERLIB)</td>
</tr>
</tbody>
</table>

3.4.2 Power Up and Idle

Upon powering up the out-of-box demo, the LCD displays a scrolling welcome message. The MSP430FR4133 then enters a loop, in which the LCD cycles through all of its segments followed by a scrolling instruction message to "Hold S1 and S2 to switch modes".

3.4.3 Stopwatch Mode

While in the power up and idle state or in the temperature sensor mode, the stopwatch mode can be entered by holding down both S1 and S2 buttons shortly. The LCD displays scrolling text "STOPWATCH MODE" to indicate successful entry into this mode.

The MSP430FR4133 initializes the stopwatch calendar to HH:MM:SS:CC = 00:00:00:00, then goes to sleep in LPM3.5. Since the onboard LCD has 6 alphanumeric digits, the stopwatch format is initially MM:SS:CC but becomes HH:MM:SS when the timer reaches the first hour.

Press the S1 button to start the stopwatch timer (counts up). While the timer is running, the MSP430FR4133 sleeps and wakes between LPM3 (waiting for RTC interrupt) and active mode (incrementing calendar and updating LCD). Press the S1 button again to stop the stopwatch timer and return the MSP430FR4133 back to LPM3.5 to conserve power. When the stopwatch timer is stopped, press the S2 button resets the timer back to 00:00:00.

While the stopwatch timer is running, press the S2 button to pause the LCD at the current time but continue the timer running in the background, allowing for the "split timer" functionality. Press the S2 button to resume display of the running timer on the LCD.

3.4.4 Temperature Sensor Mode

While in the stopwatch mode, the temperature sensor mode can be entered by holding down both S1 and S2 buttons shortly. The LCD displays scrolling text "TEMPSENSOR MODE" to indicate successful entry into this mode.

Upon entering this mode, the MSP430FR4133 initializes the ADC input to its internal temperature sensor and starts sampling/conversion at four times per second. Each time an ADC conversion completes, the LCD shows the calculated temperature to the tenths decimal place.

The temperature unit can be toggled between Celsius and Fahrenheit by pressing the S2 button. The temperature measurement can also be paused/resumed by pressing the S1 button. While the temperature measurement is running, the MSP430FR4133 sleeps and wakes between LPM3 (waiting for ADC sample/conversion to finish) and active mode (processing the results and updating LCD). When the temperature measurement is paused, the MSP430FR4133 enters LPM3.5 with the LCD remaining on displaying the last measured temperature.
4 Additional Resources

4.1 LaunchPad Websites

More information about the MSP430FR4133 LaunchPad, supported Booster Packs, and available resources can be found at:

- Tool Folder: resources specific to this particular LaunchPad
- TI’s LaunchPad portal: information about all LaunchPads from TI for all MCUs

4.2 Information on the MSP430FR4133

At some point, you will probably want more information about the MSP430FR4133 device. For every MSP430 device, the documentation is organized as shown in Table 9.

<table>
<thead>
<tr>
<th>Document</th>
<th>For MSP430FR4133</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device family user's guide</td>
<td>MSP430FR4xx and MSP430FR2xx Family User's Guide (SLAU445)</td>
<td>Architectural information about the device, including all modules and peripherals such as clocks, timers, ADC, and so on.</td>
</tr>
<tr>
<td>Device-specific data sheet</td>
<td>MSP430FR413x Mixed-Signal Microcontrollers data sheet (SLAS865)</td>
<td>Device-specific information and all parametric information for this device</td>
</tr>
</tbody>
</table>

4.3 Download CCS or IAR

Although the files can be viewed with any text editor, more can be done with the projects if they’re opened with a development environment like Code Composer Studio (CCS) or IAR Embedded Workbench.

CCS and IAR are available in full, free code-size, or time limited versions. The full out-of-box demo can be built with the free versions of CCS and IAR (IAR KickStart), because it is under the code size limit. For full functionality, download the full version of either CCS or IAR.

Go to the MSP430 software tools page to download them and for instructions on installation.

4.4 MSP430Ware and TI Resource Explorer

MSP430Ware is a complete collection of libraries and tools. It includes all of the MSP430 libraries used in the software examples. By default, MSP430Ware is included in a CCS installation. IAR users must download it separately.

MSP430Ware is built into the TI Resource Explorer, for easily browsing tools. For example, all of the software examples are shown in Figure 14.
4.5 MSP430FR4133 Code Examples

This is a set of very simple code examples (SLAC625) that demonstrate how to use the entire set of MSP430 peripherals: ADC12, Timer_A, eUSCI, and so on. These do not use driver library, rather they access the MSP430 registers directly.

Every MSP430 derivative has a set of these code examples. When writing code that uses a peripheral, they can often serve as a starting point.

Code examples can be accessed directly through MSP430Ware and the TI Resource Explorer without downloading the code examples mentioned above. TI Resource Explorer allows a one-click import of the device example code.

4.6 MSP430 Application Notes

There are many application notes at www.ti.com/msp430, with practical design examples and topics.

4.7 Community Resources

4.7.1 TI E2E™ Community

Search the forums at e2e.ti.com. If you cannot find your answer, post your question to the community.
4.7.2 Community at Large

Many online communities focus on the LaunchPad – for example, http://www.43oh.com. You can find additional tools, resources, and support from these communities.

5 FAQ

Q: I can’t get the backchannel UART to connect. What’s wrong?
A: Check the following:
• Do the baud rate in the host’s terminal application and the USCI settings match?
• Are the appropriate jumpers in place, on the isolation jumper block?
• Probe on RXD and send data from the host. If you don’t see data, it might be a problem on the host side.
• Probe on TXD while sending data from the MSP430. If you don’t see data, it might be a configuration problem with the eUSCI module.
• Consider the use of the hardware flow control lines (especially for higher baud rates).

Q: So the onboard emulator is really open source? And I can build my own onboard emulator?
A: Yes! We encourage you to do so. The design files are on ti.com.

Q: The MSP430 G2 LaunchPad had a socket, allowing me change the target device. Why doesn’t this LaunchPad use one?
A: This LaunchPad provides more functionality, and this means using a device with more pins. Sockets for devices with this many pins are too expensive for the LaunchPad’s target price.

Q: With the female headers on the bottom, the board doesn’t sit flat on the table, and I can’t unsolder them. Why did TI do this?
A: For several reasons. A major feedback item on previous LaunchPads was the desire for female headers instead of male ones. But simply using female instead is problematic, because compatibility with existing BoosterPacks would be lost, and some people prefer male headers. So, adding female headers without removing male ones satisfies both preferences. It also allows more flexibility in stacking BoosterPacks and other LaunchPads.
6 Schematics

The following figures show the schematics for the MSP-EXP430FR4133.

Figure 15. Schematics (1 of 6)
Figure 16. Schematics (2 of 6)
Figure 17. Schematics (3 of 6)
Software-controlled DCDC converter

Energy measurement method protected under U.S. Patent Application 13/329,073 and subsequent patent applications

Figure 18. Schematics (4 of 6)
USB interface and power supply

Change IC101 to adjust target voltage from 2.8V to 3.6V

Figure 20. Schematics (6 of 6)
### Revision History

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

<table>
<thead>
<tr>
<th>Changes from July 21, 2015 to January 17, 2017</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Added Rev 1.1 to Table 5, Hardware Change Log .................................................................</td>
<td>17</td>
</tr>
<tr>
<td>• Updated all figures in Section 6, Schematics .................................................................</td>
<td>25</td>
</tr>
</tbody>
</table>
STANDARD TERMS FOR EVALUATION MODULES

1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.

1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions set forth herein but rather shall be subject to the applicable terms that accompany such Software.

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned, or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production system.

2 Limited Warranty and Related Remedies/Disclaimers:

2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License Agreement.

2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM. User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10) business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day warranty period.

WARNING

Evaluation Kits are intended solely for use by technically qualified, professional electronics experts who are familiar with the dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.

User shall operate the Evaluation Kit within TI's recommended guidelines and any applicable legal or environmental requirements as well as reasonable and customary safeguards. Failure to set up and/or operate the Evaluation Kit within TI’s recommended guidelines may result in personal injury or death or property damage. Proper set up entails following TI’s instructions for electrical ratings of interface circuits such as input, output and electrical loads.

NOTE:
EXPOSURE TO ELECTROSTATIC DISCHARGE (ESD) MAY CAUSE DEGRADATION OR FAILURE OF THE EVALUATION KIT; TI RECOMMENDS STORAGE OF THE EVALUATION KIT IN A PROTECTIVE ESD BAG.
Regulatory Notices:

3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:

**FCC NOTICE:** This kit is designed to allow product developers to evaluate electronic components, circuitry, or software associated with the kit to determine whether to incorporate such items in a finished product and software developers to write software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference. Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

**CAUTION**

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

**FCC Interference Statement for Class A EVM devices**

*NOTE:* This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**FCC Interference Statement for Class B EVM devices**

*NOTE:* This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada

3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

**Concerning EVMs Including Radio Transmitters:**

This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

**Concernant les EVMs avec appareils radio:**

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: (1) l’appareil ne doit pas produire de brouillage, et (2) l’utilisateur de l’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d’en compromettre le fonctionnement.

**Concerning EVMs Including Detachable Antennas:**

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p) is not more than that necessary for successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated. Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited for use with this device.
Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d'usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur.

3.3 Japan

3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/rsds/ti_ja/general/eStore/notice_01.page 日本国内に
輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/rsds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):

1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal
Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,
2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or
3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。技術基準適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。

1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用
いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イン
スツルメンツ株式会社
東京都新宿区西新宿6丁目24番1号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/rsds/ti_ja/general/eStore/notice_02.page
電力線送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。
http://www.tij.co.jp/rsds/ti_ja/general/eStore/notice_02.page

3.4 European Union

3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):
This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.
EVM Use Restrictions and Warnings:

4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.

4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:

4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or property damage. If there are questions concerning performance ratings and specifications, User should contact a TI field representative prior to connecting interface electronics including input power and intended loads. Any loads applied outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative. During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit components may have elevated case temperatures. These components include but are not limited to linear regulators, switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the information in the associated documentation. When working with the EVM, please be aware that the EVM may become very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the dangers and application risks associated with handling electrical mechanical components, systems, and subsystems. User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees, affiliates, contractors or designers. User assumes all responsibility and liability to ensure that any interfaces (electronic and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or designers.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal, state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all responsibility and liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as accurate, complete, reliable, current, or error-free.

6. Disclaimers:

6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED “AS IS” AND “WITH ALL FAULTS.” TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSEORS OR ANY OTHER THIRD PARTY, TO USE THE EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. User’s Indemnity Obligations and Representations. User will defend, indemnify and hold TI, its licensors and their representatives harmless from and against any and all claims, damages, losses, expenses, costs and liabilities (collectively, “Claims”) arising out of or in connection with any handling or use of the EVM that is not in accordance with these terms. This obligation shall apply whether Claims arise under statute, regulation, or the law of tort, contract or any other legal theory, and even if the EVM fails to perform as described or expected.
8. Limitations on Damages and Liability:

8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE TERMS OR THE USE OF THE EVMS, REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING, OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMNITY OR OTHER OBLIGATION ARISING OUT OF OR IN CONNECTION WITH THESE TERMS, EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s) will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s), excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas, without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas. Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated
IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS” AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable standards, and any other safety, security, or other requirements. These resources are subject to change without notice. TI grants you permission to use these resources only for development of an application that uses the TI products described in the resource. Other reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims, damages, costs, losses, and liabilities arising out of your use of these resources.

TI’s products are provided subject to TI’s Terms of Sale (www.ti.com/legal/termsofsale.html) or other applicable terms available either on ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable warranties or warranty disclaimers for TI products.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated